User Guide StealthSurfer II

May 2005 Version 4.1

Copyright @ 2002 - 2005 StealthSurfer. All rights reserved

Table of Contents

Introduction ........................................................................................................................................................... 1
StealthSurfer- Portable Customized Browser ............................................................................................................... 1
StealthSurfer - Removable Flash Memory ............................................................................................................... 1
Features ................................................................................................................................................................ 1
Package Contents ................................................................................................................................................ 1
System Requirements ............................................................................................................................................. 1
Installation ............................................................................................................................................................. 2
Installation on Windows 2000 and XP ..................................................................................................................... 2
Change Password ................................................................................................................................................ 3
Initial Activation and End User License Acceptance ................................................................................................. 4
Use of the StealthSurfer Software .............................................................................................................................. 6
Firefox: ................................................................................................................................................................ 8
Anonymizer: ............................................................................................................................................................... 8
Roboform: ................................................................................................................................................................ 9
Thunderbird: ............................................................................................................................................................. 9
Unplug (remove) the StealthSurfer from the USB port .............................................................................................. 9
Trouble Shooting: .................................................................................................................................................. 9
Advanced Section: .................................................................................................................................................. 10
Specifications .......................................................................................................................................................... 10
Limited Warranty .................................................................................................................................................... 10
Copyright & Trademarks ........................................................................................................................................ 11
Contact Information .............................................................................................................................................. 11
Introduction

StealthSurfer- Portable Customized Browser

StealthSurfer is a computer peripheral designed with an eye towards privacy. A mere few millimeters in thickness and not much larger than the average fingernail, this new product delivers privacy, security and portability to consumers. The StealthSurfer acts as a personal micro storage drive that, when plugged into the USB port of a computer, allows users to surf the Web with totally privacy. Using the customized Web browser that comes preloaded on the StealthSurfer drive, all cookies, cached files and other downloaded images are securely stored privately on this removable device. Once the user is done, the StealthSurfer is removed and goes with them – ensuring complete privacy of Internet habits. Even Web-based e-mail can be stored on the StealthSurfer making this the ideal tool for office workers wishing to keep their personal email private.

StealthSurfer allows you to take your browser and all other sensitive private information completely away from your computer and keep it safe with you. StealthSurfer mass storage disk is preloaded with a customized version of the Firefox browser, Anonymous Surfing proxy and encryption software, Thunderbird email, Roboform password manager along with StealthSurfer's unique updating and error checking loader. The StealthSurfer is small enough to fit into any pocket. Once plugged into the USB port, StealthSurfer is detected by the host computer and recognized as a removable disk with no driver installation requirement. This solution provides a secure instrument that allows you to take your information, browser and all of your surfing experiences with you away from your computer, in your pocket or lock it away. Even if your StealthSurfer falls into the wrong hands security password protection keeps it private.

StealthSurfer - Removable Flash Memory

StealthSurfer is a high-speed, compact and portable mass storage disk. As an USB-based flash memory disk, StealthSurfer allows PC users to share data in size larger than 1.44MB between any notebook and desktop system with a functional USB port. No more carrying around work in a laptop computer, no more floppy disks required, and no need to burn CDs. The StealthSurfer is small enough to fit into any pocket and powerful enough to store text, presentations, spreadsheets and large multimedia files. Once plugged into the USB port, StealthSurfer is detected by the host computer and recognized as a removable disk with no driver installation requirement. You may start saving/transferring your important business or personal data just as on a supplementary hard disk. The security feature of StealthSurfer helps keep confidential data secured. Your data storage can be further enhanced by features such as no physical drive or external power supply, hot plug and play, large capacity, small dimension, light weight, and high reliability.

Features

Flash memory storage capacities; 128MB, 256MB, 512MB, and 1 Gigabyte.

Anonymous - Private, secure, portable, surfing
Private - Keep your surfing private.
No Local Files - No browser files, cookies, history on your C drive.
Keep it with you - Store your sensitive information and keep it with you.
Portable - Use anywhere, home, work, and on the road. Fits in your pocket.
Don't Get Caught - Eliminates risk of being caught with sensitive information on your computer.
Security - Password protects your information and sensitive data for your use only.
Convenient – Ideal for quickly transferring files from a laptop to a desktop or vice versa.
Easy – Plug it in and your PC sees another removable drive!
Fast – Read/Write speed many times faster than a floppy drive!
Durable – No moving parts and no batteries required!
Windows Compatible - Windows 2000, and XP computers with a USB port.

Protection plus: Goes beyond anti-virus and firewall protection. Prevent identity theft, advanced phishing scams, pharming and secure your wireless network.

Package Contents

• StealthSurfer • User's Guide • StealthSurfer License Agreement • Mozilla Firefox License Agreement • Mozilla Thunderbird License Agreement • Anonymizer License Agreement • Roboform License Agreement

System Requirements

Functional USB interface
IBM PC, Compatible PC, Notebook, Windows 2000/XP; USB 1.1 or 2.0 mass storage protocol.
Administrative rights to host machine.
Installation

Installation on Windows 2000 and XP
There is no need to install drivers. When you first connect the StealthSurfer to your computer, Windows will find it by showing “Found new hardware” and will automatically install the necessary driver. When you see the removable disk icon in “My Computer” and in your task bar at the bottom of your computer screen, you are ready to use the StealthSurfer.

Note: You must have administrative privileges to use the StealthSurfer and your USB port must be enabled.

All StealthSurfer USB 2.0 units have password protection factory enabled. Double click on “Removable Disk” under “My Computer”; you will see the dialog box (Figure 1) with an icon called “STEALTHLOCK_WP.EXE”. Double click on the icon “STEALTHLOCK_WP.EXE”. You will receive the U-Storage window (Figure 2) with a button to Login or Manage Password. Select the Login button. You will then see the Login window (Figure 3). The default password from the factory is 1111. Enter the factory pre-set password “1111”, and then click “OK” to gain access to the StealthSurfer disk. Now you can read, write, delete, copy, paste files on the disk.
Change Password

You can change your password at any time.

*Warning* Once a password has been changed there is no way to recover a lost or forgotten password. The factory cannot recover lost or forgotten passwords. There are no master passwords or backdoors. Please keep your password in a safe place and it is recommended that you use a hint that only you will know.

Double click on the file “STEALTHLOCK_WP.EXE” or the icon on the system tray; you will see the dialog box below (Figure 4).

1. Click on “Manage Password”, and then a dialog box appears. (Figure 5)
2. Enter your current password in “Password” field. (the factory default is 1111)
3. Enter your new password, confirm New Password, enter a hint if you like, and then click on “OK”

Passwords can be up to 8 digits long, consisting of letters, numbers, underscore, and spaces.
*Warning* Once a password has been changed there is no way to recover a lost or forgotten password. The factory cannot recover lost or forgotten passwords. There are no master passwords or back doors. Please keep your password in a safe place and it is recommended that you use a hint that only you will know.

**Initial Activation and End User License Acceptance**

The next step to use your StealthSurfer is to setup and expand the files. Make sure you are connected to the Internet then proceed. Once connected to the Internet click on the setup.exe icon. See figure 6.

The setup program will then prompt for confirmation of the Install process. It will automatically detect your correct drive letter for your StealthSurfer device. No changes are required. **By clicking on the Install button you are agreeing to the terms and conditions of the end user license agreements enclosed with your StealthSurfer.** Click Install to proceed. See Figure 7.
Next step you will see a window expanding the files onto your StealthSurfer. Make sure your internet connection is working as StealthSurfer will automatically obtain any required updates after expanding and installing. See Figure 8.
The Installation will again request that you confirm you have read and accept to the terms and conditions of the End User License Agreements. If you have read the agreements and agree then click OK. See Figure 9.

![Figure 9](image)

If you click Cancel then StealthSurfer will not run. If you click OK then StealthSurfer will automatically start Firefox and self register the unit.

**Use of the StealthSurfer Software**

In order to use the StealthSurfer software you must be connected to the Internet. Prior to using the StealthSurfer it is recommended that you check your Internet on your computer by ensuring that you can use Internet Explorer (IE) or any other browser on the computer.

After you have entered the password you will see the following files in the root directory of the StealthSurfer (Figure 10) If not displayed then return and Double click on “Removable Disk” under “My Computer”:

**Use of StealthSurfer Applications:**

Click on any of the four icons shown in figure 10 to start that application.

**Firefox** – browser for surfing the web and keeping all tracks off of host computer  
**Anonymizer** – use to keep all communication encrypted and to mask your IP address  
**Roboform** – great productivity tool to store your sites, login information and billing information.  
**Thunderbird** – email client to send and receive email. Portable email and leaves no tracks on computer.

![Figure 10](image)

Click on the program application you wish to run; Firefox, Thunderbird, Anonymizer or Roboform. Please note that you must be connected to the Internet. The program will start and you will see this message box (Figure 11): Starting may take a few seconds as USB flash drives operate slower than internal hard disk drives.
The StealthSurfer automatically updates its software during the startup process. Do not remove the unit during these updates as it could damage or corrupt the device. Depending upon your connection speed and size of update, this could be anywhere from a few seconds to 20 minutes.

The updating process may take a few minutes while the files on your StealthSurfer are being updated for the newest versions especially the first time you use the device. Figure 11 is displayed the first time you use StealthSurfer. All subsequent uses of StealthSurfer will display Figure 12 in the lower right hand corner of your screen. Do not remove the unit during the startup process as it could damage or corrupt the device. After starting the Firefox browser you will arrive at the StealthSurfer customer home page at http://home.stealthsurfer.biz, Figure 13.
SECURITY NOTE:

Anonymous Surfing does not automatically start when launching Firefox. If you want to Surf with an anonymous IP address and secure communications then click on the Anonymizer icon. This will then start Anonymous Surfing and Firefox automatically.

Application Specific Notes:

Firefox:

This is a fast and well known secure browser. When Firefox has completed loading the StealthSurfer home page will be displayed Figure 13. You may change your default home page however, we recommend that you check back frequently at http://home.stealthsurfer.biz for updates and useful information about your StealthSurfer.

StealthSurfer will automatically keep your Firefox browser up to date. Each time to you start Firefox the StealthSurfer USB software automatically checks and updates your files.

Upon starting Firefox your StealthSurfer launches Roboform automatically.

Anonymizer:

Reliable and fast anonymous surfing is provided by the this application. When in use your browser internet communication is sent via a proxy server thereby masking your IP address. Sites you visit will not obtain your actual IP address but one from a different computer. This further protects your privacy and identity.

All browser surfing is also encrypted. This provides enhanced protection from third parties, firewall monitoring, or unsecured wireless networks.

Note that Anonymizer is not automatically started when you start Firefox. Also, Anonymizer works for your browser and not email or other types of Internet communications.

Start Anonymizer by clicking on the Anonymizer icon in the StealthSurfer directory. To turn off Anonymizer: On the bottom right displayed on the system tray tool bar. You will see the icon . Right click and select Exit.

Testing Anonymizer: Go to http://members.stealthsurfer.com/welcome/index.shtml. This site will display the IP address that you have. If Anonymizer is turned on it will be different then if turned off. This URL is already loaded into Roboform for quick and easy testing. See Figure 14

Username is: welcome
Password is: 11111 (five ones)
Roboform:

This application is fantastic. It automatically fills in forms when shopping and remembers user names and passwords in a method that is both elegant and easy to use. It stores username and form information on your StealthSurfer drive in a password protected and encrypted file. Each file that stores unique information is called a Passcard.

The version that is included with StealthSurfer has unlimited number of Passcards for 30 days. After 30 days the product is limited to 10 Passcards. Many users will find 10 Passcards sufficient but if you require more than the product can be easily upgraded, for a nominal fee, by following the directions when prompted.

Roboform automatically starts when you launch Firefox.

**Testing Roboform:** First make sure Roboform is running. The Roboform toolbar will have Logins as an option on the top left side of your browser window. Click on Logins then click on Members Welcome. If this is the first time you are using Roboform then it will prompt you for the default password. The default password is “1111” (four ones). This will automatically take you to http://members.stealthsurfer.com/welcome/index.shtml and automatically fill in username and password information. Very nice

See Figure 14.

Thunderbird:

This is a great email client that also supports reading of Blogs and RSS feeds. You can easily setup Thunderbird to access POP3 and SMTP accounts. Many users like to read their hotmail, yahoo mail or gmail accounts using this. All email is kept off your computer.

Note that Anonymizer does not mask your IP address for email. We don’t want to help spammers.

**Unplug (remove) the StealthSurfer from the USB port**

**Warning:** Never unplug StealthSurfer while the unit light is on or flashing. The solid light being on or flashing indicates the device is being accessed. This may result in corruption of the software.

To properly shutdown and unplug your StealthSurfer follow these steps:

1. Close your applications.

   Firefox – From the File menu choose Exit or close via the X icon on top right of application.

   Anonymizer – On the bottom right displayed on the system tray tool bar. You will see the icon . Right click and select Exit.

   Roboform – One the bottom right displayed on the system tray tool bar. Your will see the icon . Right click and select Exit.

   Thunderbird – From the File menu choose Exit or close via the X icon on top right of application.

2. After lights have stopped flashing you may remove the unit.

3. There is NO need to click on the icon on the system tray bottom right to close down the StealthSurfer USB device. Its better to never use this option as a method of shutting down or removing your StealthSurfer.

**Trouble Shooting:**

Q: Cannot open stealthlock_wp.exe.
A: Make sure that your computer has administrative privileges.

Q: Can't find web site.
A: Make sure that your computer is connected to the Internet. Personal Firewalls may be blocking StealthSurfer’s access.

Q: Plugins and Updates.
A: We don’t recommend users installing third party plugins or users updating their versions of software unless you are an advanced user. We have integrated all software applications to work together on a portable device and we will continue to automatically offer our customers upgrades for these applications.
Q: How to clear the StealthSurfer cache?
A: Open Firefox. Under the Tools menu select Options: Then select the privacy tab on the left side of window. Then you can individually pick to clear the cache, history or cookies. Or you can select Clear All.

Advanced Section:

Q: How to change default startup applications when starting any StealthSurfer bundled program? (autostart.txt)
A: Plug in your StealthSurfer and using Explorer open the root directory of the drive. Open the folder called Stealth. A file called autostart.txt contains the information of those applications that will automatically start up. Open autostart.txt using notepad then modify and change. Current valid entries are: anonymizer firefox roboform thunderbird. The factory default "firefox roboform". Entries must be separated by a space.

Q: How to backup Roboform user data?
A: Plug in your StealthSurfer and using Explorer open the root directory of the drive. Open the folder called Stealth. Then open the folder called Roboform. Under the folder Roboform there is a folder called My Roboform Data. Copy this folder to your backup location. Should you need to restore this information then simply copy these file back.

Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>USB 2.0, data transfer rate up to 480Mb/sec</td>
</tr>
<tr>
<td>Capacity</td>
<td>128MB ~ 1GB</td>
</tr>
<tr>
<td>Sustained Data Transfer Rate</td>
<td>Up to 8MB/sec*</td>
</tr>
<tr>
<td>OS supported</td>
<td>Win 2000/XP</td>
</tr>
<tr>
<td>Power Supply</td>
<td>DC 5V/3.3v +/-5%, through USB port</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>&lt; 140 mA</td>
</tr>
<tr>
<td>Environmental Specifications</td>
<td>Operating Temperature: 0~60</td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>RH 80% max, non-condensing</td>
</tr>
<tr>
<td>LED Indicator</td>
<td>For file access</td>
</tr>
<tr>
<td>Dimension (L x W x H)</td>
<td>Head: 0.5 x 0.5 x 1/8 inch</td>
</tr>
<tr>
<td></td>
<td>Body: 1.4 x 5/8 x 1/8 inch</td>
</tr>
<tr>
<td>Weight</td>
<td>3 g (or 0.103 oz) approximately</td>
</tr>
</tbody>
</table>

*It varies by the configuration of your computer hardware & software.

Specifications are subject to change without notice.

USB connected devices and Windows 95, 98 ME, or NT are not compatible. StealthSurfer does not recommend or support the patches available that attempt to make USB connected devices work with Windows 95, 98, ME or NT.

Limited Warranty

StealthSurfer guarantees that every StealthSurfer is free from physical defects in material and workmanship under normal use for one year from the date of purchase. If the product proves defective during this warranty period, call StealthSurfer or use www.stealthsurfer.biz to obtain a Return Authorization Number. BE SURE TO HAVE YOUR PROOF OF PURCHASE AND THE PRODUCT’S PACKAGING ON HAND WHEN CALLING. RETURN REQUESTS CANNOT BE PROCESSED WITHOUT PROOF OF PURCHASE. When returning a product, mark the Return Authorization Number clearly on the outside of the package and include your original proof of purchase. All customers located outside of the United States of America shall be held responsible for shipping and handling charges.

IN NO EVENT SHALL STEALTHSURFER’ LIABILITY EXCEED THE PRICE PAID FOR THE PRODUCTS FROM DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE PRODUCT, ITS ACCOMPANYING SOFTWARE, OR ITS DOCUMENTATION. STEALTHSURFER DOES NOT OFFER REFUND FOR ANY PRODUCT. StealthSurfer makes no warranty or representation, expressed, implied, or statutory, with respect to its products or the contents or use of this documentation and all accompanying software, and specifically disclaims its quality, performance, merchantability, or fitness for any particular purpose. StealthSurfer reserves the right to revise or update its products, software, or documentation without obligation to notify any individual or entity. Please direct all inquiries to:

Stealth Ideas, Inc.
13636 Ventura Boulevard
Suite 504
Sherman Oaks, CA 91423
Copyright & Trademarks
Copyright © 2002, 2003, 2004, 2005 StealthSurfer, All Rights Reserved. StealthSurfer is a registered trademark of Stealth Ideas, Inc. Microsoft, Windows, and the Windows logo are registered trademarks of Microsoft Corporation. All other trademarks and brand names are the property of their respective proprietors.
No part of this guide may be used or reproduced in any form or by any means, or stored in a database or retrieval system without prior written permission from StealthSurfer, Inc.

Contact Information
For help with the installation or operation of this product, contact StealthSurfer Customer Support at one of the phone numbers or Internet address below.
Information  888-742-4747
Tech Support and RMA  888-742-4747
Fax  818-386-1171
Email  stealthsupport@avitagroup.com
Web  http://www.stealthsurfer.com